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The objective of this research is to study the factors affecting the occurrence of
drought and to analyze the drought risk areas of Phetchabun Province. There were three steps, as
follows: (1) to determine the factors used in the study based on the related research; (2) data
collection from five experts through interviews for the weighted significance of the factors by
Analytical Hierarchy Process (AHP); and (3) to analyze the drought risk areas by using Potential
Surface Analysis (PSA) and applying the Geographic Information System (GIS) and displayed the
results in the form of maps and tables. The results of the study and the weight of the six factors were
as follows: rainfall (26.00%); watershed (21.00%); water source (17.00%); groundwater (16.00%);
and soil texture and land use (10.00%). The consistency ratio had a value of 0.01, at less than 0.1,
and was considered to be consistent and accepted. It was found that the drought risk area of
Phetchabun Province were approximately 12,396.32 sqg.km. by the calculation of a GIS operation.
The results compared to Very High Drought Risk: 1,825.34 sq.km (14.72%); High Drought Risk:
3,056.70 sg.km (24.66%); Medium Drought Risk: 3,385.28 sqg.km (27.31%); Low Drought Risk:
2,761.77 sq.km (22.28%); and Very Low Drought Risk: 1,367.22 sg.km. (11.03%). The analysis of the
number of villages at risk of drought in Phetchabun province found that of a total of 1,338 villages,
815 villages were at High Drought Risk (60.91%), 323 villages were at Medium Drought Risk
(27.88%) and 150 villages were at Low Drought Risk (11.21%). This research can be used as
supplementary data for planning drought response for people in Phetchabun province and can be

used as a guideline for further study on drought in other areas.

Keyword : Drought Risk, Analytical Hierarchy Process (AHP), Potential Surface Analysis (PSA),
Geographic Information System (GIS)
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2.6.2.3 Nundadsen1u (Irrigation area)
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a o

11 NINWENLN AL A1N1THUN AN UNSNENNIFIINTIABAZRILIARAN (AN914 5)

B34 5 TRYARTABNANNANAATTIVBAIINOWLATIZ WA NN

AAL Fudaya NI unsafinn
1 Uannuluadesed 1:50,000 NINEANENINEUATNINTAL TN
2 Ananiwihunana 1:100,000 NINNINENIENLNANA WA, 2560
3 szgzvieanunaai 1:50,000 NINTENENTIN A, 2562
4 nrnireteny 1:50,000 NINWELTIAL 1.A. 2534
5 ﬁuﬁ%u@mmmiuiﬂ 1:50,000 anvinuleunauazie 2564
6 nsldsslmfiau 1:50,000 NINELTAL 1.A. 2558
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3.2 59UFINTAYANNGLTAIT Y AIE UL LR NN B0

¥ o s Qldl A v cY A
ifaumm@mL,Luumumwmﬂfmwmm’@m@guﬂa‘mumimmumﬂ@xmum@

kTl

o A v aa

ninensun luiug GednaanaaedsduaantinauuLIANZaY (purposive sampling) Tagld
NANINUITNTAIUUAR LU T2 NN TN 992 A LT T (Y AN UA AN T TNT AL 92N U
(zﬁﬁﬁmmﬂmzmmmﬁqmmmiwaG@u, 2552) WAz (NTNTaUseny, 2555) WULUINIG
TuN19AALARN AU 5 Y111 MITUITIYATALAGNNNATUNIIANEN FATBABUAY, AN
a a v v QI % v ¥ rdla a
AANLNINEN, ANUTALTENIY, FuFIndaN wazsungldUsslamingg Inalanvuieve
AMaAT Iz AN ludsInTug @ananny uarmisdenausu (N1ANWIN N)
3.2.1 MsaanLUULAsRINanlElunsANAHald T ety
d o a . B, o R ST T
zeaian g luntsdununalidaqanny WetinaAUInIAYE29MEN
pNdIATyaasifadt axldanlsaumeuiilug (Pairwise Comparison) taaiglaaagmny
£ a o o o A 1 o 1 o &
azfeafFaLmauANAATyaesaduNaz e frateuuudunisad (nARuwIn )
LTt RIS TR TL.FYE RUTT

AN ANEYATyaadifads “Usunudlutadasiatl [F1]” uanndntlass

“Ananwidiuinia [F2)]” agwinle

1la]s 1 wisguinguilaqs 1 waz iass 2 1la]e 2
w98 (6|5 43|21 |2[3]4|5(6|7|8|9]| dnann
lulads | < o > | tunena
g1e1 [F1] oﬁ’mﬁz&’ﬁﬁmmnﬂdw = il ATYNINNIN [F2]

o

TpanafFauiiey tTade 1 7y 1fade 2 d1vinudiugn dade 1 HAuaisoy

o

) | a A o~ o o v o , & o =
HINNINB LN “N'\ﬂﬂﬂ;ﬂ” LNALNEUNL ﬁ@@ﬂ 2 LA ﬂ’]ﬁlﬂﬁ_l‘ﬂ@\ﬁmu@mﬂu 7 AR ﬂ@@ﬂ 1«

ANAATYNINNTGT TTade 2 1flu 7 win

o

TN NATIAUTINAINTUAIDINIALI AW B19iWGN Tade 2 HAdudn sy

o

24
o ' =l

NINNd1eEN “Nnge” Wanauiy Tade 1 Aeeuaesinuaziily 1/7 Adsaetne

laqel 1 wiFaunauilaqe 1 uaz ilaqs 2 tlaqe 2
Wswu 9|8 |7 6|5 43|21 |2[3]4|5[6(@)s|9]| dnann
tlutads | < o > | dhunana
5181 [F1] ﬁwuﬁz&’ﬂﬁmmﬂﬂdﬂ = ﬁﬁuﬁzﬁﬁﬁﬂ;mﬂﬂdﬁ [F2]
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3.2.2 NSRILATIZUAUAUNBULANN DL

3.2.2.1 a519msrauvsndilsaunnauilasanldanaulaiilua

au

¥ o dl v = 1 a ¢ 1
unisnsandayasomanlsannniswsaumaussgadlunisnammsng 91
TadudssuilaudrAggnandasanirunlsaunauavinle lneoiladasssuazaslu
ARANITHINTBIAIN 1Y d1fade n drAtyndnifady 2wy 3 wih Winsendeyadaauiiu 3
Tudesnnsariuszidng tadt n Tuuuiuen uaztlade o Tuuwads lunnanduniu drifade n &
o o 3 1 o ! [~3 ¥ 1 a [ [ 1
paNdrAtydeendidads o 1y 3 i Asznsendeyaiilu 1/3 Tudesmaaiu Assaetng

(1914 6)

F1974 6 Faaeiamsamrisnduesdeyanisnfsauinauiadusee

{aqs {aqs n {aqg a {aq8 A 1lada N
{laqs n 1 3 5 7
{aqs a 1/3 1 3 5
{laq8 A 1/5 1/3 1 3
1laqse N 1/7 1/5 1/3 1

11: AmuUasan Saaty and Vargas (2012)
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3.2.2.2 MaAATIERAaEUnANNEI A1 TARE

dl k4 = = dl v aa o 1 o 4
LN'ﬂiﬂNZ\]ﬂ’]ﬁ‘Lﬂ?ﬂULVIEIU?’]EIV‘WIE;IJLﬁﬂQ‘I]qﬂu_j’Ju@’ﬂ?_ILﬂuﬁ’]ﬁl’JL@ﬂlLLZ\]') e

a

AUITUUNAN TN ANAIATYIasTTAdE AnannIg (1) (2) waz (3)

" 1/n
Vi= | | a;; (1)
Jj=1
di . I -2 a e
LHE aji Af ANGILA AN TN TN
Vi Aa ANLRAE
=] o %
n AR ANUIULTARE
W (2)
Wi ~LVi
n
(3)
Swieto
i=1
dl . A 1 1 90/ o
LB Wi Af ANG91NUIN
Vi A ANLRAS
d o o/
n Af AMUIUTTARE

v
A3 7 FABENANTIENYI INT WA A ATIN 1AL 51

laqs 1laq8 n 1laqe @ 1laqe A ilaqa N
1A} n 1 3 5 7
1laqe 1/3 1 3 5
tlaqe A 1/5 1/3 1 3
ilaqe N 17 1/5 1/3 1

NRFINLUIAG 1.68 4,53 9.33 16.00
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nazanluluaA WaldnsuynaasudaArazuuuniinisuanuaslnfvnaassoniuly

WA ANYINAL 1 69

=

LN

A '

ANENBRUA

FIREN (N9 8)

laAnsataaannsiFa Ui ulade)

AN3719 8 AIBEINIANTINYIINTWAAINITHAIWANLNF

=

nazA (M99 7)

¥ =K o
LAIANNTINITIIN

Twaniastnfeeusaziaas laan13unAN lauAasLITasunsAae

1laqsl 1laqe n {laqe 2 1laqe A {laqa N NAFINUUIUAYU
lade n 0.60 0.66 0.54 0.44 2.23
ladg 0.20 0.22 0.32 0.31 1.05
ilade A 0.12 0.07 0.11 0.19 0.49
lada N 0.09 0.04 0.04 0.06 0.23
HASTINWUIAT 1.00 1.00 1.00 1.00 4.00

v ] | o o o 6 v A o 1 A
LL@QN@?QN?I@\‘]LLu'Ju‘ﬂunﬂ‘ﬁ‘ﬂ\‘l"ﬂzL‘V]Wﬂ‘]_l'ﬂ’]uquﬂ@"]ﬂ‘ﬂl‘ﬁ (NIUFAIBENAD 4)

HATINLLINeUYNEIaauNgaatauauiTadt azliFntiag

{IaaggquiazinAL 1 AYFAaLN (AN919 9)

A e o o a
Lﬂﬂiﬂﬁqﬁl"JLZ\]‘HﬁI')L@ﬂILLUULLQﬂLL’NﬂﬂE‘ILL

v
A194 9 FRALiNIANTINANTNUNMIN AN ATy IB91TTARE

¥

KNIN

UINNUNUBN

IN133INANYNLTAR LU LU
NN

1]t TIAUNMINUDY

1laqs flaqa n taqaa  ieqap  ia|a N FANUAY Wnein
1la]qe n 0.60 0.66 0.54 0.44 2.23 0.56
1laqe 0.20 0.22 0.32 0.31 1.05 0.26
1la]e A 0.12 0.07 0.11 0.19 0.49 0.12
1laqe N 0.09 0.04 0.04 0.06 0.23 0.06
SR 1.00 1.00 1.00 1.00 4.00 1.00
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3.2.2.3 NARAUANADAARDY

N1INAABLAITNABAAREINULBIMANA U1 LFAINaNn19N 4 Iaadanis

naaauiANasnAdeditetvany sl A1 Amax Azl n

patiANNaanAaad (C.1.) ulaainaunnii 5

FMIN49UANNERARARY (C.R.) M1 1lFaINENN1IN 6

(Amax . n)
= o
€ n-1) (5)
e n = anuuLlaay
— '
R (6)

hR C.R. dndauAnuaanAdas Consistency Ratio

C.I.

AIRAINNABAAREY Consistency Index

Rl = ﬁ‘ﬁﬁlﬁﬂzﬁu Random Index
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[ [ %

Inefidaiidaguiurdainuaenndes ildannisdusmedrauning
AIUNALYBUNUTTNIRTFIUANAINATATY ﬁfag’iwdw 1099 Imwﬁmﬁmmﬁmﬁﬁqzﬁuﬁﬁ
dunutladeseus 3-15 tTade Tifed (Golden & Wang, 1989)

uauilade =3 R.I.=0.58
uutfade =4 R =0.90
uauilade =5 RI.=1.12
uutlade =6 R =1.24
uuadE =7 R =1.32
uutfade =8 R =1.40
uutlade =9 R =1.45
A uaulade = 10 R = 1.49
uaufade = 11 R = 1.51
uutlase = 12 R = 1.54
Aauaulade = 13 R = 1.56
uutlade = 14 R =1.57
A uautlade = 15 R = 1.58
A1 C.R. <= 0.10 #ansuls d1 C.R. > 0.10 aausulils dasnunaunisld

ANANNANATYTBIAL LI LN
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3.3 Aisignuazlssuianadays

d‘ ¥ o d‘ =2 o 3 [ d‘ [ ¥
Lll'ﬂ?’)‘i_l?QNﬂlﬂﬁgjﬂﬂ@@ﬂVll‘iﬂuﬂ’]?ﬂﬂH’] BAZNNUUALNDLNTEALAITN LA LAY

v 1 o v b7 1 o . [ oY

aaAFaLAaldA Az UNaeLAarady (Rating)  wazni1sdaiasizidagaain
diaeqanny azlaAtaaunminaudAyseusaziady (Weighting) aniiuazyianng
Uszananataya

3.3.1 msdszntanataya

n19szananallvnIIARI AN AR ANEATAY8 TN TN ArcGIS 10.4.1
yinldlaanisulasdayaannianimesiflusaines fasiatesiie AccToolbox > Conversion
Tools > Feature to Raster (nwdsznau 7) laanwuauuiangs (Output cell size) 1l
50x50 LUAT %‘qmm:ﬁummmmummgmﬁﬂgaﬁié’?ﬁmmmémmw’mﬂmqmmiwmi

A8 W14 1:50,000

‘cToolbox 5
3l ArcToolbox
& 3D Analyst Tools
& Analysis Tools
@) Cartography Tools
1
) & Excel
= & From GPS
[ & From KML
@ & From PDF
[ & From Raster
@ & From WFS
& JSON
4 & Metadata
® & To CAD
% & To Collada
[ & To Coverage
@ & To dBASE
+ & To Geodatabase
& & To KML

» ASClI to Raster
#_DEM to Raster
Feature to Rasterl 3
, Float to Raster
y LAS Dataset to Raster
y, Multipatch to Raster
y, Point to Raster
» Polygon to Raster
y Polyline to Raster
5’ Raster To Other Format (multiple)
() & To Shapefile
@) Data Interoperability Tools
&) Data Management Tools
@ Editing Tools
& Geocoding Tools
@) Geostatistical Analyst Tools
& Linear Referencing Tools
& Multidimension Tools
& Network Analyst Tools
&P Parcel Fabric Tools

AP

nwilsznau 7 snsulasdayaainuninadidusames
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Y o e o o o Ao ' a .
’QZVLQN@@WﬁﬂﬂﬂﬂH@LLUU?’]@LW@?WQ 6 tlaqg VlNﬂ']ﬂzLLuueLuLLm@:ﬂ?ﬁ (Pixel)

1
al

aniuas MATasNan13LATIZ TN (Spatial Analyst Tools) A28A8NNT3LATI Wt aUYIL
(Overly) TagnsANUILANAZIUUIINLLLTN N MInTastfade (Weighted Sum) Aagidunng

(1) (nndsznay 8)
FLALAZLLL  (S) = W.R, +WR, +.....+ WR (1)

A o dl 1 a o ¥
e S = FLALATUUUAINNLALNFABNITNAIEILAY
W = ANftUtinA g ATy AaTTAdE
R = ANAZLULIDNTTARE

n 5 anunuiladenldlunnsama s

ArcToolbox 2 x
I]@ ArcToolbox] 1
) &9 3D Analyst Tools
@ &P Analysis Tools
@ @ Cartography Tools
i & Conversion Tools
@ @ Data Interoperability Tools

# & Data Management Tools
@ @ Editing Tools
= @ Geocoding Tools
) @ Geostatistical Analyst Tools
) & Linear Referencing Tools
@ @ Multidimension Tools
@ & Network Analyst Tools
(& Parcel Fabric Tools
@ @ Schematics Tools
@ @ Server Tools
() E) Space Time Pattern Mining Tools
2
&) & Conditional
[ & Density
[ & Distance
) & Extraction
@ & Generalization
[ & Groundwater
@ & Hydrology
[ &y Interpolation
@ & Local
@ & Map Algebra
[ & Math
@ & Multivariate
& & Neighborhood
5 & Overlay | 3
, Fuzzy Membership

#, Fuzzy Overlay
«

Weighted Overlay
[ T «
[ & Raster Creation
[ & Reclass
[ & Segmentation and Classification

@ & Solar Radiation

[ & Surface

@ & Zonal
@ & Spatial Statistics Tools
@ @ Tracking Analyst Tools

ada £ o Y a d” dl 1 9; o
nndsenavu 8 AENTTAUNULDY RLTNWUNLUUAWNUIUUN
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AN9UsENaNARINAIIR L lARNAZLUUTINIBILAAZN3A (Pixel) AINTWNINNT
o [ o > ¥ L o v aa
NIUUAAINNNIINTBIBUATNIATUII TR A (Classified) aanidlu 5 3e6L AY8AT natural

breaks (jenks) anuulgiATasiia ArcToolbox > Spatial Analyst Tools > Reclass >

o

Reclassify e unui i@l ANsaee 5, 4, 3, 2, 1 AMNAIAL WAINIUUAANFLATAINA1 19
. 4 o e vww X dd e 4 ¥
uszAuAuAeNsanIafaduuds laun 5 = NuNBeedsudaninign, 4 = Wuindeasis
3 X g . X A e v X A4 .
WAINNN, 3 = NuUNAeaABuaIlUnans, 2 = Nuldeeiauadides was 1 = NuNAeiaLas

¥
taaign
3.3.2 NMSUAPINATAYA

o A =
LL@@\‘]N@%@H@LLNHVI 2 sluuy Ae

a

3.3.2.1 WNUNUAAINUNREABLAS lWd T g sy sl wianmn919AT UL
dl o 4 o 1
Reriauds s Ausng 7

3.3.2.2 uruinanaytnuwdsiuua lusmdnmasysal wiennsamuan

AUy RLTLATTgT AL 7



unN 4

NANNSANE

] 12 ]

= = . o a s a el A o o
NMsANEILTY “N1sUsrynelldsruuansaunANNANARTNeTLATIEUNUNLR 9
v o o Sy v =2 [ d’l
wasludandninasysnl” lananisdnmn Assialilil
4.1 dayanaaiufadanldlunisdne
4.1 gadpnepnnasihwinacudAnyaeiiaas

a a‘d’l dl dl o v o o o
4.2 HAVATITUNLN L@EIQQEILL@QIH’QQMQ@LW%?H?M

4.1 TayaifeanuiladadildlunmsAnin
d‘ o A o ¥ dl =2 k3 2 o o Y v 4
WHeaAnaantdastuazsusantayanldlunisAnsinsuuas fadeaz gt el
g lugluunae9ssuuansaumARANAnT (GIS)  waruwAAINATIILIBIUNLTLAZ AT
Aunnsmesusiaziadela Al
4.1.1 Usanaeluiafasel
gAnwlasousondayaafifayniniean annsnandlauinaiuazngy

wa1lseniu T w.A. 2528-2558 (A1 30 1) a1n 23 anBludsudanasysnl Tanasaiiinelu

wuLLa lEd (m1919 10)

AN919 10 ATRUNNULLLLA s

Andnissana winely (nn.Al) sTAUNY
1 Haandn 1,088.38 dumnilasuin
2 1,088.38-1,167.63 lumnilag
3 1,167.63-1,249.02 NumAN1uNANg
4-7 1,249.02-1,358.26 Hlumpna

8-10 14INN31 1,358.26 lUANANIN
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=

antuarliazuuusssuAudeuastiadedunnelwans w5 sehu Aa

4 N 4 4 4 s 4 e 4 .
ReaNNNge 5, 1RL9NIN 4, 1@asilunana 3, @asden 2 uazidasdpangn 1 wugn Wud
doulnnjaesdaninnasysnd HUTuniluaany 1,088.38-1,167.63 Wu. HNWN 4,928.48
a v dlg/ dl 3’/ dl = dl 1 a o %
A9.0N. AALTUTRLAY 39.76 WRINUNTINNA TINANNALIADNITAATLAININ T8N
A9 UFNuUNelueas? 1,167.63-1,249.02 1N, NWLA 3,300.61 A9.nN.ARIWSasas 26.63
YAINUNININNA 1ALNFABNIFNAA LA UNAY BaziFuNnindueae Yasndn 1,088.38
HWu 2,453.01 AnfluFeaay 19.79 resiunyianne @ewsian1aiadaudsniniga (A1319

11)

;11979 11 Psunneluiede T w.a. 2564 a8999ndainasysnl

Uanaseluiadasedl (uu) Aui (m9.0%) SEAUAMNLREN jaaay
UpEININ 1,088.38 2,453,01 5 19.79
1,088.38-1,167.63 4,928.48 4 39.76
1,167.63-1249.02 3,300.61 3 26.63
1,249.02-1,358.26 1,445.37 2 11.66

NNN31 1,358.26 268.86 1 217
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4.1.2 Fnamwinmnana
f«rm?’fmg@Lmuﬁﬁﬂﬂmwﬁ’]mm@ Fandpingsysal u1ms1dau 1:100,000
UfuilgaiRouiueney w.A. 2560 SR lALN TN INEINTEALN AR NTENT
NFNENTIITHI R WA AN G Tmﬂﬁuﬁmﬂummﬁwﬁmmemafﬁﬁﬂﬂmwmmam

Uunanaladasngn 2 au.u. fa 9oTue JWuN 8,813.15 m9.nN. Faaay 71.09 T41ALNFAANNT

WU 3,503.47 A9.NN.

=

a o ¥ A a %’ ¥ ! ;/
NANELLANHIN IRIAINT AB mmmmm@im 2-10 aL.4. pia Galug

|
A

$R8AY 28.26 LATHAAUILNIANALANIANGT 10 ALY, Aaddlug HNuWA 79.70 Fasay 0.64

(199 12)

M9 12 ANENINUILIANG SINTALNTIYTOS

ANEMWUNLNANA (ALL.N/TH) AT (R5.nN) STAUAMNLAL Sasa
1aeNan 2 8.813.15 NN 71.09
2-10 3,503.47 unang 28.26

11NN91 10 79.70 1ipgl 0.64
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4.1.3 5TALUINANNUURIUN

wundouwlvnresdandnngsysal Hszazviieannuuacin Weandn 200 wng

AIBLIAQNILT 6,107.51 me.nu. Aniuianas 49.27 209NUNIINA Tdeasanisiade

b4

LANTRaNgA $898INNbALT TTUTUINAINUUAIUININNGT 500 LNAT ATALAGNWLA

¥
b

1
=

2,146.39 ma.nu. Andludesay 17.31 10aiuiisunn i lidassanisindeudaninings

LAZIzEEUINAINUNAIEN 200-300 LHAT ATRLARNNUT 1,911.67 A9.nx. Anlufesay

] 1
X a 1

15.42 94N UNNINNA TAURL9ARNTNASLAINR (119719 13)

M9 13 FreizraInNUnain Aadnmasysnl

sxﬂ:ﬁwmmmdaﬁﬁ (W) ﬁuﬁ (m9.nN.) sxﬁ'umwtﬁm Sasa
11NN31 500 2,146.39 mn%?izgm 17.31
400-500 909.51 Vel 7.34

300-400 1,321.24 unang 10.66

200-300 1,911.67 el 15.42

Weendn 200 6,107.51 fariign 49.27

2 o/

N1 1 NINNFNENIUN UAZNITATITHIBNEIAE (2564)
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4.1.4 ANHULARUUDAY

FLULUNUNINEATINANILTUNIaANT9iEgnaaulal (Agri Map Online) N9

o

AUWNTIAU NITNININHATUAZAUNIDS AINIDAUUNNGNAUL TG I patl (M99 14)

M1979 14 nguAuluandnnTsy sl

Al iud it (19) Sasns
NufinauluanAuus 3,529,185 45.78
ﬁuﬁmmﬁuqq 2,606,340 33.81
ﬁuﬁmu@u 1,495,441 19.40
fufiange 68,516 0.88
NANTAAUNEN 8,896 0.11

a

AN NINWBLINAL (2561)

AINN153ATI eI WU Nundaulunjresdandninasysalidunu

k1l

[ ]
KX A A

Wilen ATALIAGNALN 5,433.78 me.NN. visaAaLluiatay 43.83 BasWUNIauNA 39088
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4.2 uadtAsIziAnsnninANdIAaaslaqs
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TTadeARenATANTTUIUNNTIAALTUIEIRAIN ST HAdt (Nwdlsznay 15)

wAnsszidusaganfidisstnn laaslunigg

Pair-wise comparison Matrix

A 4

PARNNYIFNT AN agLnF

(Normalized Matrix)

y

AtasthuinAud Aty pasiTast

lsidanAdad (CR >= 0.1)

ANAINNADAAADINULD

LWBHA (CR)
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azsimzuuud ba 114 1um1319 Pair-wise comparison Matrix (11314 19)

a LY 1
4.2.1 mseansndulsaunauilaasilua

u

F11979 19 AN ATIENdL Beunauadenilug

= o(— e(_ =

= & A_g «é ’ § &

& & & a & 1=

o < = MR = =

1< | = —o — I

g Ao(_ = Z & (,E‘n

= S < & 2 2

< = 4 39 < %

a [y —g a 33 B

o X =g S o 39 ?:l iﬂg r.(n;

tlaqaldlunisAne é i § = N =
1Bunnutluiaaaged 1.00 2.00 2.00 2.20 1.20 2.20
ANEININUILNAA 0.50 1.00 1.00 1.80 0.60 2.00
TLEIZUNNANNLIAAIUN 0.50 1.00 1.00 1.80 1.00 2.00
TR RN GG 0.47 0.60 0.50 1.00 0.50 1.00
WUNTUA NN 0.90 1.80 1.00 1.80 1.00  2.00
RREIG MEA GG AN 0.47 0.50 0.50 1.00 0.50 1.00
HASINLUIRAY 3.83 6.90 6.00 9.60 4.80 10.20
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1 1
[ a o

WagdanlafunaresnisetnuudNn BRI @ aadnyiinsdssidus e gau

Q) o

2
'

ATLTIY 5 YINWUAD Azt AT WWWIRNE @Iy NALNI AN AULAIN NI eR s AzLUW LAY
ilade anntiuaziaziuun sl g luansaavsnduzaumanadtiug e ldaiuned
aeLTERIAE WaldAudsazyinnismnasntesusazuns luuwwsana lduumsng

wanwag1nd (Normalized Matrix) sia’ldl



62

4.2.2 HAaNIFAIUIUIIAT Normalized Matrix WRIAG
ANIUNANTTNEwanLadln® (Normalized Matrix) 911 betaetinAni lanmns

3 : 4
ANEINATINTRILFAZ LN TULUAFS (19149 20)

A1919 20 ANLNNTNDWANLAILNF

= soSo FYS N =

= & 5 «é _§ &

G [N & a & =

o = = MR = =

1© | = b = &

@ 205 = & = &

= = & & o »

= = o> 3 & %»

a (e -g a = aa

o o - < o 55 2 nE o

ilaqanldlunisAnsn o 3= b y= = e

5 8 R =
1Bunnutluiaaasad 0.26 0.29 0.33 0.23 0.25 0.22
ANEININLNLNANA 0.13 0.14 0.17 0.19 0.13 0.20
TLEIZUNNANNLIAANUN 0.13 0.14 0.17 0.19 0.21 0.20
Tab TR RN G 0.12 0.09 0.08 0.10 0.10 0.10
WUNTUAIN NN 023 026 017 019  0.21 0.20
Al e Teminpiu 0.12 0.07 0.08 0.10 0.10 0.10
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4.2.3 nan1sAuasANNnlnANNdIAaa9ilaas
AINUUNINITIINAANUANUNA TUUUINEU KARUINATINTYBILAAZUAD
LuueuuIIAtanuauTadaianne azlaAdaainminaudAnyresusaziiade en

o £ 1 o
LDNATAINNUALHADININU 1 (A58 21)

A9 21 ANURANTNENUinANdATyaaiade
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e & g & i _"é = o

o [N & @ & s « 74

o < = R = = = @

1< — = = — I c =

& Aog (E @ & & g DC

= = @ g & 2 = =

E: = & S o 2 £

o o e & = g g . @ dog

ﬁQQHmﬁ”lu g g D) c 1= "?—: & Erd

P q%lv S g E@ Aﬂx E = '8

N1SANEN & % £
Funauseasgne ] 026 029 033 023 025 022 158 0.26
ANEAINUILIAG 013 014 017 019 013 020 095 0.16

FLETUNANNLIAAIEN 013 014 017 019  0.21 0.20 1.03 017

TR RN 012 009 008 010 010 010 0.60 0.10

|

2 £Z
o

uifuAuNIWgNdl 023 026 0417 019 021 020 125 0.1

=L

A9l s Teminan 012 0.07 008 010 010 010 058 0.10

N'&‘i')NLLu’)l;ly/d 1.00 1.00 1.00 1.00 1.00 1.00 6.00 1.00
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4.2.4 NANNTATUIUUIAIFAAARDINUADILUANA (Consistency Ratio)

AauA Amax TaglaainnistinienamuaedAndiass lulufAaunasunn
o , ~ \ v o Y v o 9 o P
NpusatiaIINAeAt B ueuLEa AT LA INaR lANAMAY Ine HRdaas 1
131NN Microsoft Excel TuWaridi Matrix Multiplication function (MMULT) kaau1369¢!
' = | | . . dl o ¥ o o o [V
ARAL LU UAULAAZLOU89AN Normalized Matrix taAUIARe e duilLaaazlaen

, v e s o S N I - 7
Consistency Measure a1ntiuinauasuyniladtudainunmiAieds Meeaanlauiiae
An1a9 Amax taadinisiiagutiuiannaanadednuateanysniazyinlian Amax = n

ANNNTANURERaRrTUAs 1FAN Amax = 6.08

v
o KX 9 ¥ o

7NAN )\max = 6.08 %\‘]N’mﬂ'ﬁ’] N ANHURIADIATIARDLANNNADAANDII LD

e A v
WARA IREN1IUNAIATHANARAAADY (C.1.)

(lmax - n)

or==2"

C.I. =(6.08-6)/(6-1)
C.l. =0.02

ANTUALADINIE AT BANEBAARDRY (C.R)  d1N1saAundlsann
fnsdiulTeLNeUszudNgAATANNARAAReY (Consistency Index, C.l.) NAuanule

AINANINLNTISNT NUAATHANAAAAABLTIEN (Random Consistency Index, R.l.) &9

e CR AR 8mIdiuUANNdanAdes (Consistency Ratio)
C.l. A8  A1sgHANNAeanAded (Consistency Index)

Rl A8 ANATEIEH (Random Ratio)
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anuauilade = 6 asfasldAn R = 1.24

AN C.R. NA1unul@Aa C.R. = 0.02/1.24
C.R.=0.01

nrmNansuntadtuInndvzawindy 5 1Tads luaasiANAYL 0.10 &1usu 4
Tadt TdAnetAAY 0.09 tazda1usy 3 tTadeldAasilANAu 0.05 nsAnEIASITlANAN TN
6 1lad8 AN189 C.R. WAL 0.01 B9ALNINUTaNTL 0.10 A9UUNANITILATIZHAATTING

uminaugAtyaasiladt DadnlAuaennaea N Tnaaniule

4.3 NAILATISUNUMALINBUWATIUAINI AL NTT YT
4.3.1 HARIAZLUULATAIANUINTINANNAIATYILIAAE

A9 22 ANAZLUY (Rating) wazANtagUMinANg1Atyaasiladt (Weighting)

AL 1aas LI NISNANT U ANDA9UIUUN ANAZLLUY
ANMNAIATYTRY  URdiAas
{laqs

1 Sunouslseds et 8891 1,088.38 Nl 0.26
1,088.38-1,167.63 HN.
1,167.63-1,249.02 NX.

N W B~ O

1,249.02-1,358.26 {U.

1INN91 1,358.26 1. 1

2 ANUAINUNLIANA $198IN91 2 AU.N./Ta TN 0.16

2-10 AU.N./T TN

N W b~

2NN 10 AL N./Da TN

3 F2EUINRAINLUAILN 11NNT1 500 LR 0.17
400-500 LumT
300-400 wume

N W b~ O

200-300 tHm?

1198191 200 LNAT 1
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200000+

100000+

0
14

Snap breaks to data values

Classification X
Classification Classification Statistics
Method: | Natural Breaks (Jenks) v Count: 7747682
Classes: _5 v Minimum: 142
5 Maximum: 490
Calzbidaor sum: 2,551,594,924
| Exduson... | | samping... | Mean: 329.3365582
Standard Deviation: 54,60591973
Columns: [Jshow std. Dev. [[]show Mean
g 3 seskiabes [
4000007 g § g g 259,3647059
2 2 2 304.4
B L2 2 345.3411765
300000+ 3890117647
490

Layer Properties

General Source Key Metadata Extent Display Symbolbgy
Show:

’Draw raster grouping values into cla

[ 345.3411765 - 389.0117647

I 335.0117647 - 430

Vector Field

Unigue Values

Steldhed iy e

Dis:retle s Value }«'!MI:IE» | Normalization | <None> .
Classification

Natural Breaks (Jenks) Closses|s  v| [ dlassify.. |

ot | T
Symbol  Range Label
I 142 - 259.3647059 142 - 259.3647059
[ 259.3547059 - 304.4 259.364706 - 304.4
[ ]304.4-345.3411765 3044000001 - 345.3411765

345.3411766 - 389.0117647
389.0117648 - 490

[[]show dlass breaks using cell values
[Juse hilshade effect z |1

Display NoData as

Lok || Comcel | [ hesh

(2)
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Legend

Weighte_tif3

<VALUE>

142 - 259.3647059

259.364706 - 304.4

304.4000001 - 345.3411765

345.3411766 - 389.0117647|

389.0117648 - 490

nisznew 18 uanisfauriudeya@anuLULdaenmin
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F1199 23 HANNTILATIZNUNLAENAUUAS Aandaunasysnl

SEAUANNIRES AUl (m9.n3) jasaz
L?immm‘/‘izgm 1,825.34 14.72
Resann 3,056.70 24,66
Reathunans 3,385.28 27.31
Restion 2,761.77 22.28
L?ﬁlﬂﬂﬁﬂﬂ‘ﬁlqm 1,367.22 11.03
SANTINHA 12,396.32 100.00

N1 N9AATITIReEIa (2564)

AMNFENTN 23 HANTIATITHNUMALIAEUAIIINTAINETYIO] WUTT LRENNIN
V4m 1,825.34 m3.nu. Anlufesas 14.72 @eNuan 3,056.70 ms.nu. Anduiatas 24.66
Resiunany 3,385.28 me.nw. Aawlufenas 27.31 @aeer 2,761.77 n3.ny. Antufay

Az 22.28 uazideNaangn 1,367.22 ne.nw. Aniluiasas 11.03

FIN979 24 HANTIAIN YN UNIREAUUAYI8E NS AaudpIwaT sy snd

aLna Uasl Sasaz unang sasaz N faeaz  Mufisan

(Mg9.nN.) (m5.NN.) (m5.nN.) (M5.nY.)
lag 1,211.86 53.76 487.42 21.62 555.05 24.62 2,254.32
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The Application of Geographic Information System for Analyzing Drought Risk Area

in Phetchabun Province
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Abstract
This research aims to assess drought risk area, analyze drought risk area by applying Geographic
Information System (GIS). And to find the relationship between the factors and the risk of drought in Phetchabun
Province. The research process consisted of 3 steps: 1) to study the factors; by reviewing literature and research

related to drought; 2) collecting data; both the context of the study area, interviews with 12 experts through a

' ananiTngiRansauma AnzdsaNAnanT iAanenauATuATuNTI IR

Program in Geoinformatics, Faculty of Social Sciences, Srinakharinwirot University

1483




102

v
¥

mMsUszgadanisszAuTR AR 18 inanendainemsAans e At unaLal FuR 8-9 fuanAN 2564

purposive sampling. To find the average from the given factors and collecting information about factors; and 3)
processing and analyzing the data. By weighted and rated each factor. Linear regression is used to model the
relationship between drought risk and the factors influencing drought risk. And applying the geographic
information system (GIS) to analyze drought risk area.

The results showed that Phetchabun Province Which has an area of 12,396.32 square kilometers,
found that the areas at low to moderate risk of drought cover the most provincial areas. It has an area of
approximately 3,488.45 and 2,993.40 square kilometers. It is an area with physical factors that cause drought
such as average rainfall over a period of 30 years, groundwater potential, distance from irrigation areas, soil
drainage, watersheds, and drought incidence statistics which is related to the mountainous terrain in the north
and is parallel on both sides in the east and west of the province. Affecting the supply of water reservoirs
causing water shortages leading to drought. Affecting activities necessary to use water in consumer. Including

agricultural activities that require large amounts of water.

Keyword: Drought Risk Area, Geographic Information System

E-mail address: panya.sanitwong@gmail.com
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